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1 Product Instruction

1.1Product Overview

The GW6L-B0(L256) is a Slice PROFINET protocol conversion gateway module. As a slave module, the

GW6L-B0(L256) can be combined with other gateway slave modules to form a gateway kit. Different

combinations of gateway kits are able to bi-directionally transmit 256-byte IO data between two masters,

such as EtherCAT, PROFINET, EtherNet/IP, CC-Link, PROFIBUS-DP, DeviceNet masters, etc., which has the

advantages of high real-time performance, optimized system configuration, simplified on-site wiring, and

improved system reliability. It realizes the communication demand of connecting different networks

quickly and efficiently.

1.2Product Characteristics

 Supports interconversion of multiple types of protocols

EtherCAT, PROFINET, EtherNet/IP, CC-Link, PROFIBUS-DP, DeviceNet in a two-by-two

arrangement.

 Supports bi-directional transfer of IO data between two protocols

The data interaction length supports 256 bytes.

 small volume

Compact and small footprint.

 easy diagnosis

Innovative channel indicator design, close to the channel, channel status at a glance, easy to

detect and maintain.

 easy configuration

Simple configuration and support for mainstream EtherCAT, PROFINET and EtherNet/IP masters.

 easy installation

DIN 35 mm standard rail mounting

Adopts pop-up terminals and standard RJ45 network interface, wiring is convenient and fast.
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2 Designation Rules

2.1Gateway Designation Rules

Number Meaning Description

(1) Gateway

Abbreviations
GW: Gateway

(2) Product

Series

6: Slice

(3) Gateway

Versions

L: Limited length version

U: Universal Universal version

E: Extended

(4) bus protocol A: EtherCAT

B: PROFINET

C: EtherNet/IP

D: CC-Link

E: DeviceNet

F: PROFIBUS-DP

G: Modbus TCP

H: CANopen

I: CC-Link IE Field Basic

J: MECHATROLINK

(5) Module Type 0: Slave module

1: Master Module
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(6) comment

form

L256: Data interaction length 256 bytes

2.2Gateway Suite Designation Rules

Number Meaning Description

(1) Gateway

Abbreviations
GW: Gateway

(2) Product Series 6: Slice

(3) Gateway

Versions

L: Limited length version

U: Universal Universal version

E: Extended

(4) bus protocol A: EtherCAT

B: PROFINET

C: EtherNet/IP

D: CC-Link

E: DeviceNet

F: PROFIBUS-DP

G: Modbus TCP

H: CANopen

I: CC-Link IE Field Basic

J: MECHATROLINK

(5) Module Type 0: Slave module

1: Master Module

(6) bus protocol A: EtherCAT

B: PROFINET

C: EtherNet/IP

D: CC-Link

E: DeviceNet

F: PROFIBUS-DP

G: Modbus TCP

H: CANopen

I: CC-Link IE Field Basic

J: MECHATROLINK

(7) Module Type 0: Slave module

1: Master Module
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(8) comment form L256: Data interaction length 256 bytes

2.3List of commonly used modules/kits

Model Product Description

GW6L-A0(L256) Slice Gateway EtherCAT Slave Module (fixed length 256 bytes)

GW6L-B0(L256) Slice Gateway PROFINET Slave Module (fixed length 256 bytes)

GW6L-C0(L256) Slice Gateway EtherNet/IP Slave Module (fixed length 256 bytes)

GW6L-D0(L256) Slice Gateway CC-Link Slave Module (fixed length 256 bytes)

GW6-P20HM Slice Gateway Power Modules

GW6-CVR Slice Gateway Terminal Cover

GW6L-A0B0(L256) Slice Gateway EtherCAT Slave to PROFINET Slave Kit (fixed length 256

bytes)

GW6L-B0B0(L256) Slice Gateway PROFINET Slave to PROFINET Slave Kit (fixed length 256

bytes)

GW6L-B0C0(L256) Slice Gateway PROFINET Slave to EtherNet/IP Slave Kit (fixed length 256

bytes)

GW6L-B0D0(L256) Slice Gateway PROFINET Slave to CC-Link Slave Kit (fixed length 256

bytes)

Note: The gateway kit contains gateway power module × 1, gateway module × 2, and gateway terminal

cover × 1.
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3 Product Parameters

3.1General parameter

General technical parameters

Size Power Module

GW6-P20HM

106 x 61 x 22 mm

Gateway Module

GW6L-B0(L256)

106 x 61 x 25.7 mm

Terminal cover GW6-CVR 106 x 61 x 7.7 mm

Weights Power Module

GW6-P20HM

110 g

Gateway Module

GW6L-B0(L256)

80 g

Terminal cover GW6-CVR 20 g

Operating temperature -10℃~+60℃

Storage temperature -20℃~+75℃

Relative humidity 95%, non-condensing

Protection class IP20

Installation DIN 35 mm standard rail mounting

3.2Power supply parameters

Power supply parameters

Power Module

GW6-P20HM

Operating

power

24 VDC (18V~30V)

output voltage 5 VDC

Output Current 2 A

Gateway Module

GW6L-B0(L256)

Operating

power

5 VDC
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Operating

Current

400 mA

power (output) 2 W

3.3Interface parameter

PROFINET interface parameters

Product model GW6L-B0(L256)

Bus protocol PROFINET

Data transmission

medium

Ethernet/PROFINET CAT5 cable

Transmission

distance

≤100 m (station to station distance)

Transmission rate 100 Mbps

Bus interface 2 x RJ45

Process data

volume: downlink

256 Bytes

Process data

volume: Uplink

256 Bytes
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4 Panel

4.1Product structure

Name of each part of the product
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4.2Application

Gateway kit (power module + gateway module 1 + gateway module 2 + terminal cover)

Take the GW6L-B0C0(L256) gateway kit as an example, the application method is shown in the following

figure.

4.3Indicator light function

Power Module Identification and Indicator Lights

Name Markings Color State State Description

5V power

indicator

P GREEN ON Working power supply is normal

FLASHING 80% overload, cut off power to back-end

loads

OFF The product is not powered or the power

supply is abnormal

Load

indicator

O RED OFF Not overloaded

ON Load up to 90%

FLASHING 80% overload, cut off power to back-end

loads
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Gateway Module Logo and Indicator

Name Markings Color State State Description

Power

indicator

P GREEN ON Working power supply is normal

OFF The product is not powered or the power

supply is abnormal

System

Indicator

Lights

L GREEN ON Data conversion interactions are normal

OFF
Data conversion interaction exception

warning

indicator

B RED OFF Profinet bus parameters are set properly.

FLASHING Profinet bus parameters not set or

abnormal

Operation

status

indicator

R GREEN ON The system is functioning normally

OFF
System operational anomalies

Network Port

Indicator

IN ORANGE FLASHING Connection established with data

interaction

OFF No data interaction or exception

GREEN ON Establish a network connection

OFF No network connection established or

abnormal

OUT ORANGE FLASHING Connection established with data

interaction

OFF No data interaction or exception

GREEN ON Establish a network connection

OFF No network connection established or

abnormal
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5 Installation and uninstall

5.1Overall Dimension

Power module outline specifications (unit:mm)
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Gateway Module Form Factor (unit:mm)

End cap outline specifications (unit:mm)

Note: All are installed with DIN 35 mm standard rail, DIN rail specification 35*7.5*1.0, 35*15*1.0 (unit mm).
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5.2Installation Guide

Precautions for installation\uninstall

 Ensure that the cabinet is well ventilated (e.g., the cabinet is fitted with an exhaust fan).

 Do not install this equipment next to or above equipment that may cause overheating.

 Be sure to install the module vertically and maintain air circulation around it (at least 50mm air

circulation space above and below the module).

 Once the module is installed, be sure to secure the module by installing rail mounts on both ends.

 Be sure to disconnect the power supply when installing/uninstalling.

Minimum clearance for module installation (≥50mm)
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Ensure that the module is installed vertically

Be sure to install the rail mounts

5.3Installation and uninstall steps

Module Installation and uninstall

Module Installation

Steps

1. Install the power supply module first on the rail that has been fixed.

2. Install the gateway module to the right of the power module in order.

3. After installing all gateway modules, install the end caps to complete the

installation of the modules.

4. Install the rail fixings on both ends of the power module and end cap to fix

the module.

Module uninstall

procedure

1. Loosen the guide rail fixings at both ends of the module.

2. Use a one screwdriver to pry off the module snap.
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3. Pull out the uninstalled module.

5.4Installation Diagram

Power Module Installation Step

Align the power module guide rail slot

vertically with the guide rail, press the power

module, and hear the "click" sound, the

module is installed in place, as shown in the

left figure ①.

①

Gateway Module Installation Step

Align the slot of the gateway module rail

with the right side of the power supply

module and push it in as shown in Figure 2

on the left. Press the gateway module firmly,

and when you hear a "click" sound, the

module will be installed in place.

②
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Follow the steps in the previous step of

installing the gateway module to install the

second gateway module, as shown in Figure ③

on the left.

③

End cap retrofit Step

Install the end cap on the right side of the

last module as shown in Figure ④ on the left,

and refer to the installation method of the

gateway module.

④
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Retrofitting of guide rail fixings Step

Fasten the left side of the power supply

module and the right side of the end cap

module, and install the rail fixings as shown in

Figure ⑤ on the left.

⑤

Push the rail fixture firmly in the direction of

the gateway module to ensure that the

module is mounted tightly, and use a

screwdriver to lock the rail fixture as shown in

Figure ⑥ on the left.

⑥

Uninstall Step

Loosen the rail retainer at one end of

the module with a screwdriver and

move it to one side, making sure

there is a gap between the module

and the rail retainer, as shown in

Figure ⑦ on the left.
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⑦

Insert a flat head up into the snap of the

module to be uninstalled, and exert

force in the direction of the module

sideways (hear the rattling sound), as

shown in Figures ⑧ and ⑨ on the left.

Note: Each module has a snap at the

top and bottom, all operate in this

way.

⑧

⑨

Uninstall the module by doing the opposite

of installing the module, as shown in Figure

⑩ on the left.

⑩
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6 Wiring

6.1wiring terminal

wiring terminal

power supply

terminal

extremity 3P

wire diameter 22~16 AWG 0.3~1.5 mm²

bus interface 2×RJ45 Category 5+ UTP or STP (STP recommended)

6.2Wiring instructions and requirements

Wiring Tool Requirements

The power supply terminal adopts screwless design, and the

installation and removal of cables can be operated with a one-type

screwdriver (specification: ≤3mm).

Stripped Wire Length Requirements

The recommended cable stripping length for the power terminals

is 10 mm.
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Power module wiring method

For single stranded hard wires, after stripping the corresponding

length of wire, press down the button while inserting the single

stranded wire.

Multi-stranded flexible wires, after stripping the corresponding

length of wire, can be directly connected or supporting the use of

the corresponding standard specifications of the cold compression end (tube-type insulated terminal, the

reference specifications are shown in the table below), press down the button at the same time the line

will be inserted.

The power supply terminal specifications are shown in the table below:

Tube Insulation End Specification Sheet

specification
model number

Cross-sectional area of

conductor mm²

Tube insulated terminal L with a length of 10 mm

E0310 0.3

E0510 0.5

E7510 0.75

E1010 1.0

E1510 1.5

Power supply wiring precautions

 PE must be reliably grounded.

Bus Wiring Method

Standard RJ45 network interface with standard crystal connector is used, and the pin assignment is

shown in the table below.
pin

number

code

1 TD+

2 TD-

3 RD+

4 "one"

radical in

Chinese



GW6L-B0(L256) Protocol Gateway Module User's Manual 6 Wiring

20 Copyright © Nanjing Solidot Electronic Technology Co., Ltd. 2024

8

1

1

8

Precaution

 Double shielded (braided mesh + aluminum foil) STP cables of category 5 or higher are recommended

as communication cables.

 The length of the cables between the devices must not exceed 100 m.

characters

(Kangxi

radical 1)

5 "one"

radical in

Chinese

characters

(Kangxi

radical 1)

6 RD-

7 "one"

radical in

Chinese

characters

(Kangxi

radical 1)

8 "one"

radical in

Chinese

characters

(Kangxi

radical 1)
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Power supply wiring: power module 3P terminal

Using the DC24V power module, refer to the wiring method and connect the power supply according to

the circuit shown in the following figure, and at the same time ground PE reliably (twisted-pair wire is

recommended for the power supply cable).

6.3wiring diagram

Taking GW6L-B0C0(L256) as an example, the topology connection method is shown below.
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7 Operation

7.1Description of process data

Uplink data (256 bytes)

functionality Meaning address range

input data

The input data of gateway module 1 in the kit

corresponds to the output data of gateway module 2
First 255 bytes

The input data of gateway module 2 in the kit

corresponds to the output data of gateway module 1

status bit

0x00 (Hex): no data interaction between gateways

Last 1 byte
0x01 (Hex): there is data interaction between the

gateways

0x02 (Hex): Gateway power-down state

Downlink data (256 bytes)

functionality Meaning address range

output data Output data of the gateway module First 255 bytes

reserve NULL Last 1 byte
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7.2Module Configuration Description

7.2.1 GW6L-A0B0(L256) in TwinCAT3 and TIA Portal V17 Software Environment

7.2.1.1Preliminary

 hardware environment

 Module preparation

This description uses the GW6L-A0B0(L256) gateway kit as an example

 Two computers, one pre-installed with TwinCAT3 software and one pre-installed with

TIA Portal V17 software

 Shielded cables for EtherCAT

 Shielded cables for PROFINET

 One Siemens PLC

This description is based on the example of Siemens S7-1200 CPU 1214C DC/DC/DC

 Two switching power supplies

 Module mounting rails and rail mounts

 Device Configuration Files

Configuration file access: https://www.solidotech.com/documents/configfile

 Hardware configuration and wiring

Follow "5 Installation and uninstall" and "6 Wiring".

https://www.solidotech.com/documents/configfile
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7.2.1.2Communication connection in TwinCAT3 software

1、 Preset GW6L-A0(L256) Configuration File

a. Place the ESI configuration file (EcatTerminal-XB6_V3.10_ENUM.xml) in the TwinCAT installation

directory under "C:\TwinCAT\3.1\Config\Io\EtherCAT" as shown below.

2、 Create Project

a. Click the TwinCAT icon in the lower right corner of the desktop and select "TwinCAT XAE (VS xxxx)"

to open the TwinCAT3 software as shown below.
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b. Click "New TwinCAT Project", in the pop-up window, "Name" and "Solution name" correspond to

the project name and solution name respectively. "Location" corresponds to the project path,

these three items can be selected by default, click "OK", the project was created successfully, as

shown in the following figure.

3、 scanning device

a. After creating the project, right-click on the "Scan" option under "I/O -> Devices" to perform a

slave device scan, as shown in the following figure.
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b. Check the "Local Connection" box, as shown in the following figure.

c. Click on the pop-up window "Scan for boxes" and select "Yes"; click on the pop-up window

"Activate Free Run" and select "Yes". "Yes", as shown in the figure below.

d. After scanning to the device, you can see Box1 (GW6L-A0(L256)) in the left navigation tree, and

you can see TwinCAT is in the "OP" state in the "Online" section, and you can observe that the RUN

light of the slave device is always on, as shown in the figure below.
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4、 Viewing uplink and downlink data

a. The left navigation tree "Box1 -> Inputs" displays the uplink data of the gateway module, which is

used to check whether the data is correctly imported, as shown in the following figure.

b. In this example, the range of 39~293 bytes in the uplink data is the input data, totaling 255 bytes;

the 294th byte, i.e., the last byte, is the status bit, as shown in the figure below.
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c. The left navigation tree "Box1 -> Outputs" displays the downlink data of the gateway module,

which is used to force the output of data, as shown in the following figure.

d. Right-click on any double-byte, such as "O00", select "Display Mode" to set the data display

format to hexadecimal/decimal, select "Online Write Select "Online Write" to write the value online,

as shown in the figure below.
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7.2.1.3Communication connection in TIA Portal V17 software

1、 New project

a. Open TIA Portal V17 software and click “Create New Project”.

 Project name: customizable, can be left as default.

 Path: the project keeps the path, which can be left as default.

 Version: can be left as default.

 AUTHOR: The default can be maintained.

 Comment: Customizable, may not be filled in.

2、 Adding a PLC controller

a. Click “Configure A Device”, as shown in the following figure.



GW6L-B0(L256) Protocol Gateway Module User's Manual 7 Operation

30 Copyright © Nanjing Solidot Electronic Technology Co., Ltd. 2024

b. Click "Add New Device", select the PLC model you are currently using, and click "Add", as shown in

the following figure. After adding, you can see that the PLC has been added to the device

navigation tree.

3、 Scanning connected devices

a. Click "Online Access -> Update Accessible Devices" in the left navigation tree as shown below.
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b. When the update is complete, the connected slave devices are displayed, as shown in the

following figure.

The IP address of the computer must be in the same network segment as the PLC, if not, modify

the IP address of the computer and repeat the above steps.

4、 Adding a GSD Configuration File

a. In the menu bar, select "Options -> Manage General Station Description File (GSDML) (D)".

b. Click Source Path to select the file.

c. Check if the status of the GSD file you want to add is "Not yet installed", click Install if it is not

installed, or Cancel if it is already installed to skip the installation step.
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5、 Adding Slave Devices

a. Double-click on "Devices & Networks" in the left navigation tree.

b. Click the "Hardware Catalog" vertical button on the right, the catalog is displayed as shown below.

c. Select "Other field devices -> PROFINET IO -> Gateway -> Sdot -> X-Bus -> GW6L-B0(L256)".

d. Drag or double-click "GW6L-B0(L256)" to the "Network View" as shown below.

e. Click "Unassigned (blue font)" on the slave device and select "PLC_1.PROFINET Interface_1" as

shown below.
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f. When the connection is complete, it is shown below.

g. Click on the device name to rename the device, as shown in the following figure.

h. Click "Device overview" to enter the device overview, you can see the topology configuration

information, including the I/O address automatically assigned by the system, the I/O address can

be changed by yourself, as shown in the following figure.
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6、 Assign device name

a. Switch to "Network View", right-click the connection cable between PLC and GW6L-B0(L256), and

select "Assign Device Name".

b. The "Assign PROFINET Device Name" window pops up as shown below.

Check to see if the MAC address on the module silkscreen is the same as the MAC address of the

assigned device name.

 PROFINET Device Name: The name set in "Assign IP address and device name to slave".

 Type of PG/PC interface: PN/IE.

 PG/PC interface: the actual network adapter used.
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c. Select the slave device in turn, click Update List, and click Assign Name. Check whether the status

of the node is "OK" in "Accessible nodes in the network", as shown in the following figure.

d. Click Close.

7、 Download Configuration Structure

a. In Network View, check PLC.

b. Click the button in the menu bar to download the current configuration to the

PLC.

c. In the "Extended Download to Device" pop-up screen, configure the following figure.
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d. Click the "Start Search" button as shown below.

e. Click on "Download".

f. Select "Continue without synchronization" as shown below.
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g. Select "Stop All".

h. Click Load.

i. Click Finish.

j. Power the unit back up.

8、 communication connection

a. Click the button ,and then click the "Go Online" button, the connection is

successful, as shown in the following figure.
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9、 Viewing uplink and downlink data

a. Expand the left side of the project navigation, select "Monitor and Force Meter", as shown in the

following figure.

b. Double-click "Add New Watch Table", the system adds a new monitor table, as shown in the

following figure.
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c. Open the Device View and check the channel Q address (channel address of the output signal) or I

address (channel address of the input signal) of the module GW6L-B0(L256) in the device

overview.

For example, the "Q address" of GW6L-B0(L256) module is 2 to 257, and the "I address" is 68 to

323, as shown in the following figure.

d. Input the address, data type and comments in the Address cell of the monitoring table to facilitate

monitoring. You can refer to the definition of the uplink and downlink process data, enter the data

items in order, press the Enter key, and then click the button to monitor the data after all the

fields are filled in.

e. The module's uplink data is shown below in the monitoring table to see if the data is coming in

correctly.
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f. In this example, the range of 68~322 bytes in the uplink data is the input data, totaling 255 bytes;

the 323rd byte, i.e., the last byte, is the status bit, as shown in the figure below.

g. The downlink data of the module is shown below in the monitoring table for forcing the output

data as shown below.
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h. In the "Modify Value" cell enter the value, click the button to write, write the value, as shown in

the figure below.

7.2.1.4data interaction

a. After establishing the communication connection, the value is written in the downlink data of

TwinCAT3 software and the output data is shown below.
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b. In the monitoring table of the TIA Portal V17 software, check the uplink data to confirm that the

data is entered into the gateway module, as shown in the following figure, the data has been

passed in.

c. At this point, the last status bit byte of the TIA Portal V17 software uplink data is 16#01 indicating

that there is data interaction between the gateways, as shown in the following figure.
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d. In the monitoring table of the TIA Portal V17 software, write the downlink data as shown below.

e. Check the uplink data in TwinCAT3 software to confirm that the data has been entered into the

gateway module, as shown in the following figure, the data has been passed in.
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f. At this time, the last status bit byte of the TwinCAT3 software uplink data is 0x01 (Hex) indicating

that there is data interaction between the gateways, as shown in the following figure.

7.2.2 GW6L-B0C0(L256) in TIA Portal V17 and KV STUDIO software

environment

7.2.2.1preliminary

 hardware environment

 Module preparation

This description uses the GW6L-B0C0(L256) Gateway Kit as an example

 Two computers, one pre-installed with KV STUDIO Ver.10G software and one

pre-installed with TIA Portal V17 software

 Shielded cables for EtherNet/IP

 Shielded cables for PROFINET

 One Siemens PLC

This description is based on the example of Siemens S7-1200 CPU 1214C DC/DC/DC

 One Keens PLC

This description takes the KV-8000 as an example

 Two switching power supplies

 Module mounting rails and rail mounts

 Device Configuration Files

Configuration file access: https://www.solidotech.com/documents/configfile

 Hardware configuration and wiring

Follow "5 Installation and uninstall" and "6 Wiring".

https://www.solidotech.com/documents/configfile
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7.2.2.2Communication connection in TIA Portal V17 software

1、 New construction

a. Open the TIA Portal V17 software and click “Create New Project”.

 Project name: customizable, can be left as default.

 Path: the project keeps the path, which can be left as default.

 Version: can be left as default.

 AUTHOR: The default can be maintained.

 Comment: Customizable, may not be filled in.

2、 Adding a PLC controller

a. Click “Configure A Device”, as shown in the following figure.

b. Click "Add New Device", select the PLC model you are currently using, and click "Add", as shown in

the following figure. After adding, you can see that the PLC has been added to the device

navigation tree.
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3、 Scanning connected devices

a. Click "Online Access -> Update Accessible Devices" in the left navigation tree as shown below.

b. When the update is complete, the connected slave devices are displayed, as shown in the

following figure.
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The IP address of the computer must be in the same network segment as the PLC, if not, modify

the IP address of the computer and repeat the above steps.

4、 Adding a GSD Configuration File

a. In the menu bar, select "Options -> Manage General Station Description File (GSDML) (D)".

b. Click Source Path to select the file.

c. Check if the status of the GSD file you want to add is "Not yet installed", click Install if it is not

installed, or Cancel if it is already installed to skip the installation step.
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5、 Adding Slave Devices

a. Double-click on "Devices & Networks" in the left navigation tree.

b. Click the "Hardware Catalog" vertical button on the right, the catalog is displayed as shown

below.

c. Select "Other field devices -> PROFINET IO -> Gateway -> Sdot -> X-Bus -> GW6L-B0(L256)".

d. Drag or double-click "GW6L-B0(L256)" to the "Network View" as shown below.

e. Click "Not assigned (blue font)" on the slave device and select "PLC_1.PROFINET Interface_1" as

shown below.
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f. When the connection is complete, it is shown below.

g. Click on the device name to rename the device, as shown in the following figure.

h. Click "Device overview" to enter the device overview, you can see the topology configuration

information, including the I/O address automatically assigned by the system, the I/O address can

be changed by yourself, as shown in the following figure.
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6、 Assign device name

a. Switch to "Network View", right-click the connection cable between PLC and GW6L-B0(L256), and

select "Assign Device Name".

b. The "Assign PROFINET Device Name" window pops up as shown below.
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Check to see if the MAC address on the module silkscreen is the same as the MAC address of the

assigned device name.

 PROFINET Device Name: The name set in "Assign IP address and device name to slave".

 Type of PG/PC interface: PN/IE.

 PG/PC interface: the actual network adapter used.

c. Select the slave device in turn, click Update List, and click “Assign Name”. Check whether the

status of the node is "OK" in "Accessible nodes in the network", as shown in the following figure.
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d. Click Close.

7、 Download Configuration Structure

a. In Network View, check PLC.

b. Click the button in the menu bar to download the current configuration to the

PLC.

c. In the "Extended Download to Device" pop-up screen, configure the following figure.

d. Click the "Start Search" button as shown below.
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e. Click on "Download".

f. Select "Continue without synchronization" as shown below.

g. Select "Stop All".

h. Click Load.

i. Click Finish.

j. Power the unit back up.

8、 communication link

a. Click the button, ,and then click the "Go Online" button, the connection is

successful, as shown in the following figure.
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9、 Viewing uplink and downlink data

a. Expand the left side of the project navigation, select "Watch and force tables", as shown in the

following figure.

b. Double-click "Add New Watch Table", the system adds a new monitor table, as shown in the

following figure.
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c. Open the Device View and check the channel Q address (channel address of the output signal) or I

address (channel address of the input signal) of the module GW6L-B0(L256) in the device

overview.

For example, the "Q address" of GW6L-B0(L256) module is 2 to 257, and the "I address" is 68 to

323, as shown in the following figure.

d. Input the address, data type and comments in the Address cell of the monitoring table to facilitate

monitoring. You can refer to the definition of the uplink and downlink process data, enter the data

items in order, press the Enter key, and then click the button to monitor the data after all the

fields are filled in.

e. The module's uplink data is shown below in the watch table to see if the data is coming in

correctly.
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f. In this example, the range of 68~322 bytes in the uplink data is the input data, totaling 255 bytes;

the 323rd byte, i.e., the last byte, is the status bit, as shown in the figure below.

g. The downlink data of the module is shown below in the monitoring table for forcing the output

data as shown below.
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h. In the "Modify Value" cell enter the value, click the button to write, write the value, as shown in

the figure below.



GW6L-B0(L256) Protocol Gateway Module User's Manual 7 Operation

58 Copyright © Nanjing Solidot Electronic Technology Co., Ltd. 2024

7.2.2.3Application in KV STUDIO software environment

1、 Create Project

a. Open KV STUDIO software, select "File -> New Project".

b. In the pop-up box, fill in the "Project Name", select "PLC Model", "Position", as shown in the figure

below

.

 Project name: Customize.

 PLC model: View the PLC appearance and select the corresponding model, e.g. KV-8000.

c. The "Confirm Unit Setting Information" window pops up, and you can select to start the Unit Editor,

close the dialog box, or read the unit configuration from the PLC as necessary. Select "No" to

demonstrate the operation, as shown in the figure below.
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2、 Communication settings

Select the communication method, if the PLC and the host computer software are connected through

a network cable, select "Ethernet", if connected through USB, select "USB".

Procedure for "Ethernet" operation

a. Click the button on the menu bar to display the “Communication Settings” window as

shown below.

b. Select "Ethernet", click "Destinations", select "1 sample", configure the IP address, and click

"Search Destination Target". Click "Find Connection Target", as shown in the following figure, the

IP address is configured in the "192.168.0" network segment.
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c. In the “Search Destination” pop-up window, select the “network card” and click “Execute”,

as shown in the following figure.

d. Select the found PLC and click "Execute" as shown in the following figure.
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e. Click the "OK" button on the Communication Settings window.

"USB connection" operation method

Select USB on the "Communication Settings" screen.

3、 EtherNet/IP settings

a. Double click "Unit Configuration -> KV-8000 -> EtherNet/IP R30000 DMI10000" in the left

navigation tree to bring up the "EtherNet/IP Settings" window. Select "Manual" or "Auto

Configuration" as required. Select "Manual" to demonstrate the operation as shown in the figure

below. When the setting is completed, click "OK" to close the window.

4、 Installation of EDS files

a. Right-click the KV-8000 in the Unit Editor window and select "EtherNet/IP Settings" to enter the

settings page as shown below.
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b. Click "EDS File" in the menu bar of the "EtherNet/IP Settings" screen, and then click "Registration"

as shown in the following figure.

c. In the folder where the EDS file is placed, select the EDS file of the corresponding model and click

"OK", the configuration file installation is completed, as shown in the following figure.
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5、 topological configuration

Topology configuration can be "manually added" and "auto-configuration" two ways, this

configuration using manual configuration.

a. Enter the "EtherNet/IP Settings" page and switch to the "Search Unit" tab, as shown in the

following figure.
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b. Click , select the communication path, and the USB connection method is shown in the

following figure.

c. "PC Ethernet Port Direct Link" is the network cable connection method, as shown in the following
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figure.

d. Select "PC Ethernet Port Direct Link" to bring up the "Select NIC" window, and set the local NIC

and IP address, as shown in the following figure.
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e. Click to search for devices connected to the network. Set the IP address segment for

searching, and click "Search" as shown in the following figure.

f. When the search is complete, the display is shown below.
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g. Double-click on the found device to add it to the configuration, as shown below.

6、 Setting the IP address

In the interface of the found device, double-click the IP address column and configure the IP address

in the pop-up box. The default address network segment is 192.168.0.

Description:

-The timeout for setting the IP address needs to be configured to 60s.

-If the dipswitch is configured with an IP address, the IP of the dipswitch prevails.

In this example, the GW6L-C0 (L256) uses a dial-up IP address of 192.168.0.1.

7、 Configure the amount of uplink and downlink data

a. Click the Switch Mode option in the menu bar to switch to Editor mode, as shown in the following

figure.
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b. Enter the "EtherNet/IP Settings" screen and click "Exclusive Owner" to bring up the "Connection

Settings" window. In the "Connection Settings" window, click "Setup Parameter" as shown below.

c. In the "Setup Parameter" window, you can configure the uplink and downlink data volume, the

uplink and downlink data volume are 256 bytes, as shown in the figure below. Click "OK" to save
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the settings.

d. In the Connection Settings window, click OK.

e. In the EtherNet/IP Settings window, click Apply and click OK.

f. In the Cell Editor window, click Apply and click OK.



GW6L-B0(L256) Protocol Gateway Module User's Manual 7 Operation

70 Copyright © Nanjing Solidot Electronic Technology Co., Ltd. 2024

8、 Configuration Download

After module configuration and parameter setting are completed, download to PLC operation is

performed.

a. Click "Monitor/Simulator (N) -> Transfer to PLC -> Monitor Mode (C)" in the menu bar as shown

below.

b. The Transfer Program window pops up, check "Clear Program in PLC", click "Select All", click

"Execute" to download the program to the PLC, as shown in the following figure.
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c. A prompt box pops up "Change to PROGRAM mode and overwrite? Continue?" Click to select

"Yes" as shown below.

d. After writing to the PLC is completed, a pop-up box will appear, "Change to RUN mode", click and

select "Yes", as shown in the figure below, to enter the monitoring mode.

e. After the configuration is downloaded, it is shown in the following figure.
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9、 data monitoring

a. In monitor mode, double-click the "GW6L-C0(L256)" icon to open the monitor table, and you can

monitor the uplink and downlink data. The uplink data is shown in the monitor table as below,

which is used to check whether the data is correctly transmitted.

b. The first byte range of W00~W07F in the uplink data of this example is the input data, totaling 255

bytes; the last byte of W07F is the status bit, as shown below.



GW6L-B0(L256) Protocol Gateway Module User's Manual 7 Operation

73 Copyright © Nanjing Solidot Electronic Technology Co., Ltd. 2024

c. The downlink data of the module is shown in the monitoring table as follows, which is used to

force the data to be output, and the display format can be switched as shown in the following

figure.

d. In the "current value" cell enter the value, write the value, as shown below.
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7.2.2.4data interaction

a. After establishing the communication connection, the value is written in the downlink data of the

KV STUDIO software, and the output data is shown below.

b. In the monitoring table of the TIA Portal V17 software, check the uplink data to confirm that the

data is entered into the gateway module, as shown in the following figure, the data has been

passed in.
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c. At this point, the last status bit byte of the TIA Portal V17 software uplink data is 16#01 indicating

that there is data interaction between the gateways, as shown in the following figure.

d. In the monitoring table of the TIA Portal V17 software, write the downlink data as shown below.

e. Check the uplink data in the KV STUDIO software to confirm that the data has been input to the

gateway module, as shown in the following figure, the data has been transmitted.
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f. At this time, the last status bit byte of the KV STUDIO software uplink data is 16#01 indicating that

there is data interaction between the gateways, as shown below.
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